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Read and understand all the instructions to avoid injury to yourself and damage to the unit. 

Do not expose to extreme temper-
atures (above 95°F or below 23°F).
Do not expose to moisture. 

Do not apply excessive pressure
to the device. Do not drop the
player. 

Do not let any foreign matter spill
into the device. 

Do not place heavy objects on top
of the device.

Do not expose to chemicals such
as benzene and thinners. 

Do not use the unit near any 
appliance that generates a strong
magnetic field.

Do not expose to direct sunlight
or heat sources. 

Do not store in dusty areas. Do not try to disassemble and
repair the device yourself. 

I Earphones 
Follow Traffic Safety Instructions
● Do not use the earphones while driving an automobile or riding a bicycle.  

It’s not only dangerous, but also against the law. 
● It may cause an accident if you turn up the volume of the earphones while walking,

especially crossing at intersections. 

Protect your ears
● Do not turn up the volume too high. Doctors warn against prolonged exposure to high volume. 

● Stop using the device or turn the volume down if you have ringing in your ears.

I Ambient operating conditions 
● Ambient temperature : 5°C ~ 35°C (41°F ~ 95°F) 

Humidity : 10 ~ 75%

I Environmental Information 
● Follow local guidelines for waste disposal when discarding packages, batteries, 

and old electronic appliances.  
● yepp packages use cardboard, polyethylene etc., and do not use any unnecessary materials.  

✽ Please be aware that we disclaim all responsibility for damages from loss of saved
data due to breakdown, repair or other causes. 
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!

!
CAUTION

RISK OF ELECTRIC SHOCK. DO NOT OPEN

The uninsulated parts inside the charger could cause electric shock.
For your safety, do not open the charger's case.

Read this User Manual to prevent any problems that
may occur while using the charger.

A charger is supplied with your YH-999 Player

Plug the charger into a wall outlet and attach
the player to the charger.

✽ When the battery is fully charged, the orange
light will change to green.

✽ Battery recharge time in normal operation is
approximately 4 hours.

CCCaauutt iioonn
- To avoid electric shock, use the charger only with a power outlet that matches the

shape of the converter's plug.

- Make sure that the charger's plug is inserted all the way into the outlet.

✍

CCaauutt iioonn
- Do not plug several devices into the same outlet.

- Do not use a charger that is defective.

- When using the rechargeable battery for the first time or after several months of non-use,
fully charge it first.

- Do not charge the rechargeable battery for more than 12 hours.

- Overcharging or overdischarging will reduce the battery life.

- The rechargeable battery is a consumable item and its capacity will decrease gradually.

- Do not let metallic objects, such as necklaces or coins, come into contact with the terminals
(metallic parts) of the charger and the built-in rechargeable battery. A fire or electric shock
may result.

- Do not touch the charger with wet hands.

✍

WWaarrnn iinngg
- Use the charger away from water sources to avoid fire or electric shock.

✍
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End User Notice
Microsoft® Windows Mobile™ Software for Portable Media Centers

WWaarrnn iinngg
Operating certain parts of this Device while driving can distract your attention away from the
road, and possibly cause an accident or other serious consequences.  
Do not change system settings while driving. Stop the vehicle in a safe and legal manner
before attempting these operations. This is important since while setting up or changing some
functions you might be required to distract your attention away from the road and remove your
hands from the wheel.

General Operation
Prolonged Views of Screen
If you are driving, do not access any function requiring a prolonged view of the screen. 
Pull over in a safe and legal manner before attempting to access a function of the system
requiring prolonged attention. Even occasional short scans to the screen may be hazardous if
your attention has been diverted away from your driving task at a critical time.

Volume Setting
Do not raise the volume excessively. Keep the volume at a level where you can still hear 
outside traffic and emergency signals while driving.  Driving while unable to hear these 
sounds could cause an accident.

WM DRM Device Labeling
This product is protected by certain intellectual property rights of Microsoft Corporation. 
Use or distribution of such technology outside of this product is prohibited without a license
from Microsoft Corporation or an authorized Microsoft Corporation subsidiary."

Mass Storage Device Support
● You can use the built-in 20GB hard drive to store your entire music library, 

plus use it as an external drive on your PC to store other data files.

WMV & ASF Playback
● You can play back ASF and WMV files.
● You can convert various kinds of video files to WMV files using 

Windows Media Player 10. 
(Convertible File Formats: AVI, MPEG, MPE, MPG, AU, SND)

MP3 & WMA Playback 
● The player supports playback of both MP3 and WMA.

Image File Viewer Function
● You can view image files in JPEG format.
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3.5” Color TFT LCD
● You can enjoy high quality video and image files.

High Speed Transfer via USB 2.0
● Maximum transfer speed of 480 Mbps.

High-Fidelity Sound  
● The player has a built-in equalizer to adjust sound to your preference. 

Built-in Rechargeable Lithium Battery
● The player contains a rechargeable lithium battery that can play music files

up to 12 hours and video files up to 3 hours.

Portable Media Center
AH81-01686A

USB Cable
AH81-01626A

A/V cable
(video/audio)
AH81-01627A

Charger
AH81-01625A

User Manual
AH68-01636B

Installation CD
AH81-01628A

Carrying Case
AH81-01624A

Earphones
AH30-00063B

Remote Control
AH81-01623A

● The appearance of the accessories shown is subject to change for product improvement
without prior notice.

● The capacity of the useable built-in memory is less than indicated as the internal firmware
uses a part of the memory as well.

Model

Built-in memory

YH-999

20GB
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Remote control jack

A/ V Out jackEarphone jack

Hold switch

USB Cable
Connection Port

DC-IN
Connection Port

Display

Volume controller

Reset Hole

E-Home
button

Power
On/Off

Skip/Search
button

Play/Pause button

External Speaker Move/Select(OK)

Previous Screen Button

NNoottee
- Reset the player by pressing the RESET hole using a pointed object such as a safety clip.

✍

I Remote Control I Standing Position

I Display

Earphone jack

Skip/Search
button

HO
LD

 

Play/Pause 
button

Skip/Search
button

Volume control

HOLD switch

Battery remaining indicator

Hold indicator

Repeat play indicator
Shuffle play indicator

Display

¤¤ By opening the SYSTEM switch on
the rear of player, you can watch a
movie or listen to music while YH-999 
is in standing position.
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2 Follow the instructions in the window to complete the installation.

▼
▼

The PC system must meet the 
following specifications:
● Pentium 300MHz or greater
● Windows XP series
● 64MB of available hard disk space
● CD-ROM drive

(double speed or greater)
● USB port (2.0) supported
● Windows Media Player 10 series

¤¤ System Requirements.

I Installing software

1 Insert the Installation CD into the
CD-ROM drive. 
The following picture appears. 
Click [Next].

Make sure to install Windows Media Player10 before connecting the
player and PC. 
If 'Add New Hardware Wizard' appears, press the [Cancel] button and install the
Windows Media Player10.

NNoottee
- Make sure to install it in the Administrator account.

Installation will not proceed if you are not in the
Administrator account.

- Make sure you have the latest driver updates from
Microsoft to ensure proper operation of this product.
Click on the Start button in the lower left corner of your
PC screen, then click on "Windows Update". You will be
directed to Microsoft's Windows Update webpage. 

✍



17

Connecting the Player to PC

E
N

G

Connecting the Player to PC

16

How to check USB driverHow to check USB driver

Windows XP: 

Control Panel ➝ System ➝ Hardware ➝ Device Manager ➝ 
Samsung PMC YH-999

1 Connect a USB cable to the USB port

on the computer.

2 Connect the other end of a USB cable
to the USB cable connection port on
the side of the player.
● [MTP media player] window will

appear with “Searching New Hardware” 
message.
Go to the device manager to check
that installation has been successfully
completed.

U
S

B
 connect cable
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I Downloading Files
1 Connect the player to PC.

2 Run the Windows Media Player10.
● Select [Start] → [Programs] → [Accessories] → [Entertainment] →

[Windows Media Player10] in the desktop.

3 Select [Sync].

1 Video file: WMV, ASF formats

2 Audio file: MP3, WMA formats 

3 Image file: JPEG format

● You can download several types of files using Windows Media Player 10.

The file, downloaded from WMP10 to the player, will be automatically saved in Music,
Pictures or Videos format depending on file folder. 

4 When the [Sync] window appears,
select the file you want to transfer to
the player, drag and drop it to the left
[Sync List] window. 

6 You can check the transferred file in
the right window. 

5 Press the [Start Sync] button on the 
main screen. 

NNoottee
- If the video file is not in WMV or ASF format, it is automatically converted to WMV format during 

downloading. (Convertible file format: AVI, MPEG, MPE, MPG, AU, SND)

✍

NNoottee
- It may take longer to download large video files.
- DivX files can only be downloaded through

Windows Media Player 10 on a PC with DivX
codec installed.

✍
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I Using Other Functions

[Display properties and settings] button

[Create folder] button

[Delete from device] button

[Format storage media] button

I Viewing Properties
Press the [Display Properties and Settings] button.
● You can check the properties of YH-999. 

I Creating Folder
1 Press the [Create Folder] button.

2 When the [New Folder] window appears, enter the folder name and then
press the [OK] button.
● A new folder is displayed in the right window of the main screen. 

I Deleting File and Folder
Select the file or folder to delete, and then press the [Delete from Device] button.
● Selected file or folder will be deleted. 

1

1

2

3

4

2 3 4

▼
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I Formatting
1 Press the [Format Storage Media] button.

2 Press the [OK] button when a confirmation window appears. 
● A new folder is displayed in the right window of the main screen.

▼

I Downloading files
1 Connect the player to your PC.

2 Open Windows Explorer on PC.
● [Samsung Portable Media Center YH-999] is displayed in Windows Explorer.

3 Select the file to save and drag-and-drop it into the 
[Samsung Portable Media Center YH-999] ➝ [Data] folder.

When you install WMP10, the Samsung Portable Media Center YH-999 folder is created
in [My Computer]. Data folder in Samsung Portable Media Center YH-999 folder can be
used as Mass Storage. Video, audio and image files can be downloaded but cannot be
played back. 
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Updating Firmware
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1 Use the A/ V cable to connect A/ V OUT jack of the player to the Audio/Video
Input jack of a TV.

2 Select the External Input in TV menu.

3 Move to [Settings] → [Display] →[TV Out] in the menu screen of the main unit, 
and then select relevant TV format, NTSC or PAL, then press OK on the 
Main unit.
● Countries where NTSC is in use: USA, South Korea, Japan, Taiwan, Philippines, 

Chile and Mexico, etc.
● Countries where PAL is in use: European countries, Hong Kong, North Korea,

China, India, Indonesia, Singapore, Malaysia, Turkey, Brazil and Argentina, etc.

NNoottee
- When you connect to a TV, the screen is no longer viewable on the main unit.
- To return the dispay to the main unit's screen, disconnect the A/V cable or power off the unit,

then turn it back on.

✍

1 Connect the player to your PC.

To update to the latest firmware:
- Move to [Start]→[All Programs]→[Portable Media Center] on the desktop and click 

[Firmware Update].
- Firmware Update guides you to the web site to download the firmware and recovery utilities. 

After accessing to the web site, select Audio and Video/MP3 Player/MP3 Players/YH-999.

Select Firmware tab and download zip file [Latest Firmware & Recovery Utilities] under
the directory C:\Program Files\Portable Media Center.

2 Run the “Samsung PMC YH-999 Firmware update Tool.exe” in the downloaded
[Latest Firmware Utility & Upgrade Utility] folder.

3 When a firmware update window appears,
press the [File] button and then select
[Connect to Device].

4 When a device selection window appears,
select the [Samsung PMC YH-999] 
and then press the [OK] button.



27

Turning unit On/Off and using the HOLD Function

E
N

G

Updating Firmware

26

7 Select [Update OS Image] after
pressing the [File] button.

6 When a file search window appears, 
select the “EBOOT_FACTORY.bin” 
file in the 
[Latest Firmware Utility & Upgrade Utility]
folder and then press the [Open] button. 
A window will open saying “Download
Success”, and then press the [OK] button

8 When a file search window appears, 
select the "NK.bin" file in the 
[Latest Firmware Utility & Upgrade Utility]
folder, and then press the [Open] button.
A window will open saying “Download
Success”, and then press the [OK] button 

● Firmware update is completed.
● When you close the firmware update window, the player will be automatically restarted.

I Turning On/Off

I HOLD Function

Make sure to check whether the unit is fully charged before turning it on.

1 Push the SYSTEM ON/OFF switch to ON position at the rear of the main unit.
Press the Power button on the main unit.

2 To turn off the unit, press the Power button on the main unit again.
If you don’t use the main unit for long period of time, push the SYSTEM
ON/OFF switch to OFF position.

OFF ↔ ON

Use the Volume Control on the side of the main unit to adjust the volume.
● Volume can be adjusted from 0 to 20.

¤¤ Adjusting Volume

Hold Function of the Main Unit

Activate                     on the main unit.

❈ All buttons on the main unit will be disabled,
and only the buttons on the remote control can
be used for input.

❈ When you activate the HOLD switch, a "       "
appears on the display.

Hold Function of the Remote Control

Activate     on the remote control.

❈ All buttons on the remote control will be
disabled, and only the buttons on the
main unit can be used for input.

❈ When you activate the HOLD switch, 
a "       " appears on the display.

HO
LD

 

Use the Hold feature to lock and disable all buttons. The Hold feature is useful to prevent your
player from being accidentally turned off or on, or to ensure uninterrupted playback.

Press

5 Select [Update Bootloader] after 
pressing the [File] button.
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I Selecting My TV
Press the        button up or down  to select [my tv]
in the menu screen and then press the       button.

● In [my tv], you can play back recorded TV files 
created in "Media Center Edition" of Windows XP.
series. If you record a TV program using Media Center
Program, it will be saved with dvr-ms as an extension.
When you download this file using WMP10, it will 
automatically be saved in the My TV Folder so that you
can watch it in the Player. 
(For more details on Media Center Program, refer to the
manual supplied with Media Center Edition )

I Playing the file
1 Press the        button left or right to select the

desired category, then press up or down to 
select the desired file.
Category
● new : Newly downloaded file will appear for 2 weeks.
● sort by date : Saved files will appear in the order 

of date.
● sort by name : Saved files will appear in the 

alphabetical order.

2 Press the       button or            .
● Selected files will be played back.
● You can move backward or forward fast using 

the               button during playback.
● If you press the        button, it will return to the 

previous screen.

NNoottee
- If you select [play all] which is displayed in upper part of each search screen, all files in

new, albums, artists, playlists, songs and genres will be played back.
- When several music files are played back, pressing the                 button moves to the

previous/next file.
- Newly downloaded files will appear in the "new" section as well as in your library.

✍

I Selecting My Music
Press the        button up or down  to select [my music]
in the menu screen and then press the       button.
● You can play back MP3 & WMA music files

in [my music].

I Playing the File
1 Press the        button left or right to select the 

desired category, then press up or down to 
select the desired file.
Category
● new : Newly downloaded file will appear for 2 weeks.
● albums : Saved album will appear. When you 

select the album, files in the album will appear.
● artists : Files will appear by artist.
● playlists : Files saved in the playlist will appear.
● songs : Saved files will appear in alphabetical order.
● genres : Music genre will appear. If you select the

genre, the files in each genre will appear.
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I Setting the Playback Mode and EQ
1 While music file is played back, press the      

button right and left to move to playback 
mode and EQ setting screen.

2 Press the       button to select the mode you want.
● shuffle play : You can randomly repeat and listen

to several music files
● repeat play : You can play back files repeatedly.
● equalizer : You can set the desired EQ mode.

acoustic → classical → electronic → hip hop → jazz → pop → rock
● purchase: If you select the [Purchase] box, you can purchase a sample file being

played while connected to WMP 10 and the Internet.

2 Press the       button.

3 Select [play].

● Selected file will be played back.

● If you press and hold the               button 
during playback, you can move backward 
or forward quickly.

● If you press the         button right and left, 
you can select various kinds of playback screens.

● If you press the        button, 
it will return the previous screen.

▼

▼
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I Playing the Playlist

I Playlist Setting

1 Select [playlists].

2 Press the       button in [portable playlist].
● play all : All files saved in the playlist will be 

played back.
● remove all from playlist : All files saved in the 

playlist will be deleted.
● To play back one music file, move to the 

relevant file and press the button to 
select [play].

1 Move to the music file or folder you want to add to
the playlist (refer to page 28 to select desired file
or folder), and then press the       button.

2 Select [add to portable playlist] if you moved to 
the file, and select [add all to portable playlist] if
you moved to the folder, and then press the 
[OK] button. 
● Selected file or folder will be added to the playlist.

I Viewing Image File

I Selecting My Pictures

Select [My Pictures] folder in the search screen and
then Press the        button up or down to move to
the file you want to view. If you press       button, 
you can view the selected images.

Category
● new : Newly downloaded file will appear for 2 weeks.
● sort by name : Saved files will appear in 

alphabetical order.
● sort by date : Saved files will appear in the 

order of date.

Press the        button up or down  to select 
[my pictures] in the menu screen and then press 
the       button.

● You can view image files in JPEG format in 
[my pictures].
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I Setting Slide Show

I Viewing Slide Show

1 Press the        button right or left  twice to move 
to the Slide Show Setting Screen. 

2 Press the       button to set the slide show as you want.
● Shuffle : Image files will appear in random order.
● Transitions : You can set the time to move to the 

next image file.
5 sec → 7 sec → 10 sec → 15 sec → 30 sec

● Show music : When you are watching the slide show
pressing this returns to Music mode. 

I Playing Music during Slide Show
1 Press the        button during music playback.

(For more information on music playback, 
refer to Playing the File in "my music".)

2 When menu screen appears, move to 
[my pictures] and select [play slide show].
● You can enjoy slide show and music at the same time.

In the search screen or [My Pictures] folder 
selection screen, select [play slide show].
● Slide show will start.
● If you press the              button during slide show, 

the slide show will be paused.

I Playing the File

I Selecting My Videos

1 Press the        button left or right to select the 
desired category, then press up or down to 
select the desired file.
Category
● new : Newly downloaded file will appear for 2 weeks.
● sort by name : Saved files will appear in 

alphabetical order.
● sort by date : Saved files will appear in the order 

of date.

2 Press the       button or             .
● The selected file will be played back.
● You can move backward or forward fast using 

the               button during playback.
● If you press the        button, it will return to the 

previous screen.

Press the        button up or down  to select 
[my videos] in the menu screen and then press 
the       button.
● You can play back video files in WMV format in 

[my videos].



E
N

G

Setting EQ

36 37

Setting the Display

1 Select Equalizer in Settings.

2 Press the        button up or down to move to the
sound mode you want to change, and then
press the       button.
● If you press the        button, it will move to the 

previous screen.

I Backlight
● Press the        button up or down to set the Light

On Time of the screen, and then press 
the       button.

● You can set the Light On Time from 
0 to 60 seconds.

● Light is continuously on if you set it to Always on.

I Brightness
● Press the        button up or down to set the

screen brightness, and then press the       button.
● You can set the screen brightness from 1 to 5.

I TV Out
● Press the        button up or down to set the 

display, and then press the       button.
- Device display :

You can view the screen through the main unit.

- TV display(NTSC) :
You can view the screen through TV in NTSC format.

- TV display(PAL):
You can view the screen through TV in PAL format.

Select Settings in the menu screen.

1 Select Display in Settings.

2 Press the        button up or down to move to the
function you want to change, and then press 
the       button.
● If you press the        button, it will return the 

previous screen.

Select Settings in the menu screen.

Setting the Display
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I Screen effects
● Press the        button up or down to set the 

Screen effects On or Off, and then press 
the       button.

- On: The characters appearing in the screen while
screen moves will become larger and smaller.

- Off: The characters in the screen are fixed.

I Sounds
● Press the        button up or down to set Sounds 

On or Off, and then press the       button.
- On: Each time you press the button, 

there will be a beep sound.

- Off: There will not be a beep sound even if you 
press the button. 

1 Select Effects in Settings.

2 Press the        button up or down to move to 
the effect you want to change, then press 
the       button.
● If you press the        button, it will return to the

previous screen.

Select Settings in the menu screen.

I Language
● Press the        button up or down to select the 

language you want among 7 languages, and then
press the       button

- The selected language will appear in the screen.

I Standards
● Press the        button up or down to select the 

language and country suitable for your area, and
then press the       button

- Year/Month/Date will appear in the order suitable for
the country you're in.

1 Select International in Settings.

2 Press the        button up or down to move to the
function you want to change and then press 
the       button.
● If you press the        button, it will return to the 

previous screen.

Select Settings in the menu screen.

NNoottee
- The unit will automatically restart when Language or 

Standards are changed.

✍
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1 Select Restore original settings in Settings.

2 When the following confirmation message
appears, select [yes] and then press 
the       button.
● All settings will be initialized.

Select Settings in the menu screen.

1 Select Information in Settings.

2 Press the        button up or down to move to 
the player information you want to check and 
then press the       button.

● About Portable Media Center :
You can check the player name and software 
version.

● About contents :
You can check the number of files saved in the
player, as well as the amount of memory used 
and available.

Select Settings in the menu screen.

▼ ▼
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The system area is damaged due to external
impact or other effect.
1. While this image is displayed, the player

automatically recovers the system area and
is restarted after recovery. 

2. Recovery mode no. 1 is displayed after
restarting.
Instructs the user to connect the unit to the
computer and recover the HDD 
with the recovery program.

How to recover when HDD is damaged due to external impact or other effect.
To download Recovery Utility :
Move to [Start] → [All Programs] → [Portable Media Center] on your PC and click 
[Firmware Update].
Firmware Update guides you the web site to download the firmware and recovery utilities. 
After accessing to the web site, select Audio and Video/MP3 Player/MP3 Players/YH-999, 
then choose Firmware tab to download zip file [Latest Firmware & Recovery Utilities] under
the directory C:\Program Files\Portable Media Center. (See Page 25 for details)

¤¤ If the display shows the recovery mode no. 3 image:
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3. When connected to computer, the display changes to recovery mode no. 2. 
Run “Samsung PMC YH-999 Recovery Tool(update).exe” in the downloaded
[Recovery Utility] folder, and select 
[File] → [Connect to Device] → [Samsung PMC YH-999].

The data area is damaged. While this image is displayed,
the player automatically recovers the data area and is restarted after recovery. 

¤¤ If the display shows recovery mode no. 4 image:

The player cannot be recovered by the user
and should be sent to the Samsung service center for repairs. 
Call 1-800-SAMSUNG for instructions.

¤¤ If the display shows recovery mode no. 5 image:

i) Select [File] → [Update OS Image] → NK.bin in the [Recovery Utility] folder 
and select [Open]. Select [OK] when update is completed. 

ii) Select [File] → [Update fonts] → gulim.ttc [Recovery Utility] folder
and select [Open]. Select [OK] when update is completed. 

iii) Select [File] → [Update fonts] → msgothic.ttc in the [Recovery Utility] folder 
and select [Open]. Select [OK] when update is completed. 
When update is completed, close the program and disconnect the player from 
the computer. When the player is restarted, it is successfully recovered. 
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Model YH-999

Built-in Memory capacity 20GB

Voltage 3.7V (Li-ion battery)

Playing time Video : 3hours / Audio : 12 hours

Dimensions/Weight 3.82” X 4.21” X 0.81” / 8.15oz

Case Plastic/Aluminum

Noise Ratio 85dB with 20KHz  LPF

Earphones Jack Output Power 35mW/CH (16Ω)

Output Frequency Range 20Hz~20KHz

Operating Temperature Range -5 ~ +35°C(23~95°F)

File Support AUDIO : MPEG1/2/2.5 Layer3(8Kbps ~ 320Kbps, 8KHz ~ 48KHz)

WMA (8Kbps ~ 192Kbps, 8KHz ~ 48KHz)

VIDEO : WMV 7/8/9

Windows Media Player 10 does not work.
● Refer to System Requirements on page 14.

The player does not operate and nothing is played in the screen display 
window.
● Check whether SYSTEM ON/OFF switch on the rear of the main unit is set to OFF.
● Reset the player. 
● Connect the charger to charge the rechargeable battery.

There is no sound even if I press the Play Back button in music mode.
●  Check whether MP3, WMA files are saved in the main unit.

I cannot download the file.
● Check whether Windows Media Player 10 is properly installed in the computer.
● Check the USB connection between the computer and the main unit.
● Check whether the memory is full.

It takes too long to search the music files.
● It may take for a while if too many music files are saved in the main unit.

Music file or artist names are not displayed during playback.
● Check the ID3 Tag of the music file.
● Change the language setting.

When it is connected to a TV, the screen will not appear.
● If you want to see the main screen, disconnect the A/V cable.
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FCC
This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2)
this device must accept any interference received, includ-
ing interference that may cause undesired operation.

Caution: Any changes or modifications in construction of
this device which are not expressly approved by the party
responsible for compliance could void the user’s authority
to operate the equipment

Note: This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant to part
15 of the FCC Rules. These limits are designed to provide
reason able protection against harmful interference in a
residential installation This equipment generates, uses and
can radiate radio frquency energy and, if not installed and
used in accordance with the instructions, may cause harm-
ful interference to radio communications, However, there is
no guarantee that interference will not occur in a particular
installation. 

If this equipment does cause hamful interference to
radio or television reception, which can  be deter-
mined by turning the equipment off and on, the user
is encouraged to try to correct the interference by
one or more of the following measures:

Any changes or modifications not expressly

approved by the grantee of this device could

void the user’s authority to operate the device.

Name: Samsung Electronics Co., Ltd

Address: 416, Maetan-3Dong, Paldal-Gu, Suwon

City, Kyungki-Do, Korea 442-742

declares under its sole responsibility that the product

Trade Name: Samsung Electronics Co., Ltd

Model Number:  YH-999

has been tested according to the FCC/CISPR22/95

requirements for Class B devices and found compli-

ant with the following standards

This product conforms to the following
Council Directive:  
● Directive 89/336/EEC, 92/31/EEC(EMC)

● Reorient or relocate the receiving antenna. 
● Increase the separation between the equipment

and receiver.
● Connect the equipment to an outlet on a circuit

different from that to which the receiver is
connected.

● Consult the dealer or an experienced radio/TV techni-
cian for help.

Modifications

Compliance

Declaration of Conformity

EMI/EMC: AnSI C63.4 1992, FCC Part 15 Subpart B

This device complies with part 15 of the FCC Rules.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference 

received, including 
interference that may cause undesirable operation.

Party Responsible for Product Compliance

Samsung Electronics America

QA Lab.

3351 Michelson Dr. Suite #290

Irvine, CA92612



Samsung warrants this product as free of
defects in material, design and workmanship
for a period of twelve(12) months from the
original date of purchase.

If during the period of warranty this product
proves defective under normal use and service,
you should return the product to the retailer from
whom it was originally purchased. The liability of
Samsung and its appointed maintenance compa-
ny is limited to the cost of repair and/or replace-
ment of the unit under warranty. 
Return of the product for defective reasons
should be to the original purchaser; however,
Samsung Authorized Dealers and Authorized
Service Centers will comply with the warranty on
the terms issued to purchasers in the country
concerned. For further information relating to the
Authorized Service Centers contact;
1-800-SAMSUNG (1-800-726-7864)
www.samsungyepp.com

WARRANTY CONDITIONS:

1. The warranty is only valid when the warranty card is
properly completed, and upon presentation of the proof of
purchase consisting of original invoice or sales slip confir-
mation, indicating the date of purchase, dealer’s name,
model, serial No. and product number.
Samsung reserves the right to refuse warranty service if
this information has been removed or changed after the
original purchase of the product from the dealer.

2. Samsung's obligations are to the repair of the defective
part, and at its discretion, replacement of the product (ser-
vice exchange unit).

3.Warranty repairs must be carried out by an Authorized
Samsung Dealer/Service Center. No reimbursement will
be made for repairs carried out by non Samsung Centers,
and warranty coverage will not be valid for any repairs or
damage caused by such repairs.

4. Repair or replacement under the terms of this warranty
does not give right to extension to or a new starting of the
period of warranty. Repair or direct replacement under the
terms of this warranty may be fulfilled with functionally
equivalent service exchange units.

5. The warranty is not applicable in cases other than
defects in material, design and workmanship. 
The warranty does not cover the following:

◆ Periodic checks, maintenance, repair and replacement
of parts due to normal wear and tear.

◆ Abuse or misuse, including but not solely limited to the
failure to use this product for its normal purposed or in
accordance with Samsung's instructions usage and
maintenance.

◆ Use of the product in conjunction with accessories not
approved by Samsung for use with this product.

◆ Failure of the product arising from incorrect installation
or use not consistent with technical or safety standards
in current force, or failure to comply with product
manual instructions.

◆ Accidents, Acts of God or any cause beyond the control
of Samsung caused by lightning, water, fire, public 
disturbances and improper 
ventilation.

◆ Unauthorized modifications carried out for the product
to comply with local or national technical standards in
countries for which the Samsung product was not 
originally designed.

◆ Repairs performed by non-authorized service centers
such as opening of the product by a non-authorized
person.

◆ The model, serial No. and product number on the 
product has been altered, deleted, removed or made
illegible.

6. This warranty does not affect the consumer’s statutory
rights nor the consumers rights against the dealer from
their purchase/sales agreement.

WarrantyWarranty
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THERE ARE NO EXPRESS WARRANTIES OTHER
THAN THOSE LISTED AND DESCRIBED ABOVE, AND
NO WARRANTIES WHETHER EXPRESS OR
IMPLIED,INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, SHALL
APPLY AFTER THE EXPRESS WARRANTY PERIODS
STATED ABOVE, AND NO OTHER EXPRESS WAR-
RANTY OR GUARANTY GIVEN BY ANY PERSON,
FIRM OR CORPORATION WITH RESPECT TO THIS
PRODUCT SHALL BE BINDING ON SAMSUNG, SAM-
SUNG SHALL NOT BE LIABLE FOR LOSS OF REV-
ENUE OR PROFITS,FAILURE TO REALIZE SAVINGS
OR OTHER BENEFITS, OR ANY OTHER SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES
CAUSED BY THE USE, MISUSE OR INABILITY TO USE
THIS PRODUCT, REGARDLESS OF THE LEGAL THE-
ORY ON WHICH THE CLAIM IS BASED, AND EVEN IF
SAMSUNG HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. NOR SHALL RECOVERY OF
ANY KIND AGAINST SAMSUNG BE GREATER IN
AMOUNT THAN THE PURCHASE PRICE OF THE
PRODUCT SOLD BY SAMSUNG  AND CAUSING THE
ALLEGED DAMAGE. WITHOUT LIMITING THE FORE-
GOING, PURCHASER 

ASSUMES ALL RISK AND LIABILITY FOR LOSS, DAM-
AGE OR INJURY TO PURCHASER AND PURCHAS-
ER’S PROPERTY AND TO OTHERS AND THEIR PROP-
ERTY ARISING OUT OF THE USE, MISUSE OR INABIL-
ITY TO USE THIS PRODUCT SOLD BY SAMSUNG
NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF
SAMSUNG. THIS  LIMITED WARRANTY SHALL NOT
EXTEND TO ANYONE OTHER THAN THE ORIGINAL
PURCHASER OF THIS PRODUCT, IS NONTRANSFER-
ABLE AND STATES YOUR EXCLUSIVE REMEDY. 

Some states do not allow limitations on how long an
implied warranty lasts, or the exclusion or limitation
of incidental or consequential damages, so the
above limitations or exclusions may not apply to
you. This warranty gives you specific legal rights,
and you may also have other rights which vary from
state to state.
This product is for personal use only, and is only for
use in compliance with the limitations of copyright
and other laws. 

To obtain warranty service, please contact 
SAMSUNG at: 
Samsung Electronics America, Inc.
400 Valley Road, Suite 201 Mount Arlington, NJ
07856
Tel: (973) 601-6000, Fax: (973) 601-6001
1-800-SAMSUNG (1-800-726-7864)
www.samsung.com / www.napster.com
081299

WarrantyWarranty
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